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CATIA V5 Analysis



Lesson 3: Computation



Student Notes:



In this lesson, you will learn about the computation process for static analysis and how to perform computation in GPS workbench.



Lesson content:
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Case Study: Drill Press Table FE Model Computation Design Intent Stages in the Process What is Computation Solving Methods Computing a Static Case



Duration: Approximately 0.25 days
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Case Study: Drill Press Table FE Model Computation The case study for this lesson is the Drill Press Table FE model computation. The focus of this case study is to select proper computation method to solve the finite element model.



Introduction to FEA



•Exercises



GPS preprocessing



•Exercises
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(Case Study)



GPS Computation



•Exercises



GPS Postprocessing



Mesh Refinement



•Exercises



•Exercises



•Exercises



Master Project



Drill Press Table with Restraints, Load and Assigned Mesh
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Assembly Structural Analysis



Drill Press Table with Computed FE Model Lesson 3: Computation
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CATIA V5 Analysis Student Notes:



Design Intent You have to solve the Finite Element model of the Drill press Table. You will provide paths for results and computation files. You must find the number of degrees of freedom (DOF) for the FE model. Based on the number of DOF you will select the appropriate solving method. Perform a computation of the FE model. Check the contents of the log file. The resulting computation files must be saved.
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Drill Press Table Computed FE Model
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Stages in the Process This will involve following steps to perform the case study: First, You will understand what is Computation. Later you will see how to perform computation step in the GPS workbench. 1. 2. 3.



What is Computation Solving Methods Computing a Static Case
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Drill press Table computed FE Model
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Step 1: Introduction to Computation



Student Notes:



You will learn the Computation process for Static Analysis, solving methods used to solve FE model and guidelines to select proper solving method. 1. Introduction to Computation
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2. Solving Methods 3. Computing a Static Case
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What is Computation (1/2) In FEA, computation is performed to calculate unknown displacement values at nodal points of FE model. From these displacement values, other solution quantities such as Strain, Principal Stresses, Von-Mises Stresses are calculated. Calculation involves following steps: 1.



The geometry model is discretized in elements to create mesh according to assigned mesh parameters, if it is not performed at preprocessing level.



2.



All properties and applied forces are idealized at the element and nodes level.



3.



For each element, nodal forces, stiffness matrices and unknown displacement vectors are computed.
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{F} : Nodal Force Matrix [K] : Global Stiffness Matrix {U} : Nodal Displacement Matrix
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Pre-processing (FE Modeling)



Computation (Solving FE Model)



Post-processing (View Results)



Mesh Refinement Iterations



Create Reports Finite Element Analysis Process
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What is Computation (2/2) 4.



The elements connectivity is used to assemble the global stiffness, nodal forces and displacements matrices.



5.



The minimization of the potential energy lead to solve global equation using the boundary conditions to suppress the stiffness matrix singularity.



Student Notes:



{F} = [K] {U} Nodal displacements are computed. Different algorithms are used to solve the above problem depending on the size and complexity of problem.



7.



Using Strain-Displacement Relations and Stress-Strain Relations, strains and stresses are calculated.
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6.
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{ } = [B] {U} { } = [C] { }



{ } : Strain Matrix [B] : Strain-Displacement Matrix { } : Stress Matrix [C] : Stress-Strain Matrix
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Step 2: Solving Methods You will learn about methods to solve FE model, criterion to use these methods and CATIA ELFINI Solver.



Introduction to Computation



2.



Solving Methods



3.



Computing a Static Case
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1.
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Solving Method Guidelines (1/2)
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For a static analysis, the displacement vector can be computed using various solutions, depending on the model configuration. Here are the following four options for the methods: Method



Description



Benefits Quick computation



GAUSS



The direct solution is fast in run-time. It is recommended in following cases: 1. Models involving multi-load computation. 2. Large model where the number of contact elements is below 3,500.



GAUSS R6



This method is more superior than GAUSS method. GAUSS R6 uses a faster and improved algorithm.



Suitable for Non-linear cases Cheap in memory resource



GRADIENT



The iterative solution is economic in model data and workspace resource but expensive in run-time. It is especially recommended in the case of Large 3D problems having more than 400,000 DOF.



AUTO



Drawbacks 1. 2.



Memory use Extra relative stiffness added at contact nodes (to secure for a reliable stiffness matrix inversion)



1.



Computation duration (number of iterations can be high) Not suitable for Nonlinear cases



2.



Selects one of the above methods internally based on the model data
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Solving Method Guidelines (2/2) For the AUTO option, the criteria used for selection of the method internally, is as follows.



AUTO



Non-linear?



YES



GAUSS R6



NO



NO
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Huge Model? >400,000 DOF



YES



GRADIENT



You can get the number of DOF in following way. In Analysis Tools toolbar, use information icon on Mesh Image. You will get number of nodes for the FE model. You know the DOF of the node (for example, each node of the tetrahedron element in CATIA has 3 DOF). From this you will get total number of DOF for the FE model.
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What is CATIA ELFINI Solver



Student Notes:



In CATIA, computation tasks are handled by program called ELFINI Solver. ELFINI Solver mainly performs the following tasks : 1. 2. 3.



Translates all input data provided during pre-processing stage into solver-interpretable commands. Run the required numeric procedures on the Solver-interpretable data. Provide capability to visualize computed data on mesh.



All ELFINI Solver computations are stored in a structured way in two files called External Storage. CATAnalysisResults: Result data is data necessary for generating images, displacements, loads, restraints, singularities, strain energy and so forth. This data is self sufficient if only results are to be saved and no more computations should be performed from them. Result data does not require much disk space; however any additional computation must start from the beginning and therefore may take some time. CATAnalysisComputations: Computation data corresponds to matrices such as stiffness. This data is needed to perform new computations from the loaded data which will benefit from it. It is time saving, but it requires much more disk space than the CATAnalysisResults file.
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ELFINI Solver also provides a log file called FICELF that provides computation data of all the documents you computed in a CATIA session.
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Step 3: Computing a Static Case You will learn how to compute a Static Case using CATIA ELFINI Solver



Introduction to Computation Solving Methods



3.



Computing a Static Case
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1. 2.
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Computing a Static Case (1/5) Before computing a Static Case, you will see how to set the proper Data Save option and specify temporary external storage and ELFINI Log file paths. These paths need to be specified only first time. Temporary external storage is required to store data temporarily during actual computation process. 1.



Ensure that the following option is set: a. b. c. d.



In the main toolbar, select Tools > Options… Click on General tab. Select No automatic backup from Data Save options. Click OK. You need to restart CATIA to make this change into effect.
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1b



It is recommended not to use Automatic Backup option as each computation will be followed by a Save operation, thus making temporary data persistent. Check ‘No automatic backup’ option.
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1c
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Computing a Static Case (2/5) 2.



Specify temporary external storage path: a. b. c.



In Solver Tools toolbar, select Temporary External Storage icon. Click on Modify button and select the folder for Temporary computation. Click OK.



2a



2b 2c



3.



Now, you will see how to specify ELFINI log path: a. b.
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c.



In Analysis Results toolbar select Elfini Solver Log icon. Click on Modify button and select the folder for ELFINI Solver Log file. Click OK.
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3a 3a 3b 3c
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Computing a Static Case (3/5) 4.



Specify the ELFINI solver external storage path : a. b. c. d. e. f.



In Solver Tools toolbar, select External Storage icon. Click on Modify button and select the folder for CATAnalysisResults file. In File name field enter required file name. Click on Save. In similar way, select folder for CATAnalysisComputations and enter name in File name field. Click OK.



4a



4b 4e
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4f
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4c



4d
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Computing a Static Case (4/5) 5.



Compute Static Analysis: a. b. c.



Double-click Static Case Solution.1 node in the specification tree. Check the method to be used in Method field in Static Solution Parameters dialogue box. Click OK.



5a
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5b
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5c



16



CATIA V5 Analysis Student Notes:



Computing a Static Case (5/5) d.



In Compute toolbar, click Compute icon.



e.



Select All option in dropdown.



f.



Click OK. You will get Computation dialogue box with progress bar showing computation status.



5d



5e



5f
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In some cases, if equilibrium is not reached, interactive warning message may inform you that the residual forces are not negligible.
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Batch Processing While CATIA computes your analysis, the interactive mode is not available. However, if you submit the job in batch mode, you can continue interacting with CATIA while the analysis runs. Launch the Batch Processing. 1.



Select Tools > Utility…



2.



Double click AnalysisUpdateBatch.



3.



Enter the analysis file to compute in the File to compute field.



4.



Enter the folder for saving computation file in the field Folder to Save Computed Data.



5.



Click the Run to start the Batch mode computing.



1



2



3
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To Sum Up



Student Notes:
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In the following slides you will find a summary of the topics covered in this lesson.
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Introduction to Computation In Finite Element Analysis, computation is performed to calculate unknown displacement values at nodal points of FE model. From these displacement values, other solution quantities such as Strains, Principal stresses, and Von Mises stresses are calculated. After descetization, nodal displacements are calculated by solving the global equation -- (1). From displacements, using Strain-Displacement relations -- (2), strains are calculated. From strains using Stress-Strain relations -- (3), stresses are calculated.



Student Notes:



{F} = [K] {U}



-- (1)



{ } = [B] {U} { } = [C] { }



-- (2) -- (3)



Where



{ }: Strain Matrix [B]: Strain-Displacement Matrix { }: Stress Matrix [C]: Stress-Strain Matrix {F}: Nodal Force Matrix [K]: Global Stiffness Matrix {U}: Nodal Displacement Matrix



Solving Methods
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For a static analysis, the displacement vector can be computed using various methods, depending on the model configuration. There are the following four options for the methods: A. B. C. D.



GAUSS GAUSS R6 GRADIENT AUTO



For the AUTO option, the criteria used for selection of the method internally, is as shown.
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AUTO



Non-linear?



YES



GAUSS R6



NO



NO Huge Model? >400,000 DOF



YES



GRADIENT



Criterion used for selection of method.
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Computing a Static Case



Student Notes:



Before computing a static case, you need to set proper Data Save Options. Also, for the first time you need to specify some paths. You need to specify the temporary external storage path for temporary computation and ELFINI Solver Log path for storing the log of ELFINI solver. Also you need to specify ELFINI Solver External Storage path, for storing these files. Before starting the computation select the method of computation. Select the analysis case to compute and complete the computation process.
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You can also submit the job in batch mode, to continue the interaction with CATIA while the analysis runs.
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Main Tools Solver Tools 1



Temporary External Storage: lets you specify the temporary external storage path.



2



External Storage: lets you specify the external storage folder path for CATAnalysisResultss file and CATAnalysisComputations file.



2 1



Analysis Results 3



Elfini Solver Log: lets you specify the folder for Elfini solver log file.



3



Compute 4



Compute: lets you compute the analysis.
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Exercise 3A



Student Notes:



Recap Exercise 15 min



In this exercise, you will perform computation for 1D component. Detailed instructions for this exercise are provided.



By the end of this exercise you will be able to: Specify Temporary External Storage path Specify ELFINI Solver Log path Specify External Storage path
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Compute Static Analysis Case
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Exercise 3A (1/6) 1.



Open a Analysis Document. Open 3A_Hollow_Shaft_1D_Start.CATAnalysis.



2.



Specify Temporary External Storage Provide path for Temporary External Storage folder. a.



b. c. d.



Create a folder ELFINI_TEMP_Computation in C drive or drive in which you have enough space. In Solver Tools toolbar, click Temporary External Storage icon. Click the Modify button. Set path as C:\ELFINI_TEMP_Computation Click OK.



2a
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2b
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2c 2d
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Exercise 3A (2/6) 3.



Specify ELFINI Solver log file path. Provide path for ELFINI Solver log folder. a. b. c.



In Analysis Results toolbar, click on Elfini Solver Log icon. Click on the Modify button. Set the path as C:\Elfini_Solver_Logs. Click OK.



3a



3b 3c



4.



Ensure that ‘No Automatic Backup’ option is selected. Check No Automatic Backup option.
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a. b. c.



Select Tools > Options. Click on General Tab. In Data Save field, check No automatic backup option. You need to restart CATIA to make this change into effect.
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4b 4c
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Exercise 3A (3/6) 5.



Specify External Storage file path. Provide path for results and computation files. a. b.



c.



d.



In Solver Tools toolbar, click External Storage icon. Click on the Modify button for CATAnalysisResults field. Set the path same as your analysis document folder. In similar way set same path in CATAnalysisComputations field using Modify button. Click OK.



5a



5b 5c
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5d
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Exercise 3A (4/6) 6.



Specify Solving Method. Use default Auto method. a. b.



c.



Double-click Static Case Solution.1. Check Auto option in Static Solution Parameters dialogue box. Keep all other parameters default. Click OK.



6a



6b
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6c
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Exercise 3A (5/6) 7.



Compute the Analysis Case. a. b. c. d. e.



In Compute toolbar, click Compute icon. Select All in dropdown list. Check Preview option. Click OK to start computation. Click OK in Computation Resources Estimation dialogue box to continue computation. You will get Computing dialogue box with progress bar showing computation progress.



7a



7b



7c
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7d
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7e
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Exercise 3A (6/6) 8.



Check ELFINI Log file. a.



Go to the path as C:\Elfini_Solver_Logs and open the ELFINI Log File.



8a



9.



Save all the files. a. b.



Select File > Save All option. Click Yes.
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9b
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Exercise 3A: Recap



Student Notes:



Specify Temporary External Storage path. Specify ELFINI Solver Log path. Specify External Storage path.
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Compute Static Analysis Case.
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Exercise 3B



Student Notes:



Recap Exercise 15 min



In this exercise, you will perform computation for 2D component. High-level instructions are provided for this exercise. By the end of this exercise you will be able to: Specify External Storage path
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Compute Static Analysis Case
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Exercise 3B (1/2) Open an Analysis Document. Open 3B_Hollow_Shaft_2D_Start.CATAnalysis.



2.



Specify External Storage file path. Provide path for results and computation files.
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1.



Student Notes:
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Exercise 3B (2/2) 3.



Specify the Solving Method. Use Gauss R6 as solving method, as it is fast and uses improved algorithm .



4.



Compute the Analysis Case. Compute the Analysis Case with Preview option unchecked.



5.



Check ELFINI Log file.



6.



Save all the files.



Copyright DASSAULT SYSTEMES



Student Notes:
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Exercise 3B: Recap



Student Notes:



Specify External Storage path.
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Compute Static Analysis Case.
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Exercise 3C



Student Notes:



Recap Exercise 15 min



In this exercise, you will perform computation for 3D component. High-level instructions are provided for this exercise. By the end of this exercise you will be able to: Specify External Storage path
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Compute Static Analysis Case
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Exercise 3C (1/2) Open a Analysis Document 3C_Hollow_Shaft_3D_Start.CATAnalysis.



2.



Specify External Storage file path.
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1.



Student Notes:
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Exercise 3C (2/2) 3.



Specify the Solving Method. Use Gauss R6 as solving method, as it is fast and uses improved algorithm.



4.



Compute the Analysis Case.



5.



Check ELFINI Log file.



6.



Save all the files.
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Exercise 3C: Recap



Student Notes:



Specify External Storage path.
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Compute Static Analysis Case.
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Case Study: Computing Drill Press Table



Student Notes:



Recap Exercise 30 min



You will practice what you have learned, by completing the case study model. In this exercise, you will compute FE model for Drill Press Table. Recall the design intent of this model: Specify the External Storage path. Select the solving method. Compute the Analysis Case. View the ELFINI Log file.
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Save all the documents
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Case Study: Introduction The case study for this lesson is the Drill Press Table FE model computation. The focus of this case study is to carry out computation task independently. You will perform the following steps in order to achieve this. Specify the External Storage path. Select the appropriate solving method based on solving method guidelines. Compute the Analysis Case. View the ELFINI Log file. Save all the documents
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1. 2. 3. 4. 5.
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Drill press Table FE Model
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Design Intent



Student Notes:



You will provide paths for results and computation files. Specify External Storage file path You will then find the number of DOF for the FE model and based on that you will select the solving method. You can get the number of DOF in following way. In Analysis Tools toolbar, use information icon on Mesh Image. You will get number of nodes for the FE model. For Tetrahedron element in CATIA you have 3 DOF per node. From this you will get total number of DOF for the FE model. Use this information along with solving method guidelines. Use solving method based on above information. Compute the Analysis Case. Check ELFINI Log file.
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Save all the files.
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Do It Yourself



Student Notes:



Copyright DASSAULT SYSTEMES



The following steps offer hints to guide you through the computation of FE model for Drill Press Table. 1.



Open an Analysis Document Drill_Press_Table_Computation_Start.CATAnalysis.



2.



Specify the External Storage file path.



3.



Specify the Solving Method. Use Gauss R6 as solving method, as it is fast and uses improved algorithm.



4.



Compute the Analysis Case.



5.



Check the ELFINI Log file.



6.



Save all the files.
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Case Study: Computing Drill Press Table Model Recap



Student Notes:



Specify External Storage path. Select the solving method. Compute the Analysis Case. View ELFINI Log file.
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Save all the documents.
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